Tell me about the World Wide Web (Web)

The World Wide Web is an extremely popular way for people to travel the Internet. Without using your
keyboard, you can point and click on the Web’s visual interface to surf from site to site. On the Web,
you can find information on subjects that interest you, read interesting articles from Web-based
magazines or learn about products for sale across the world.

Traveling the Web is like working with a Windows Help file. To navigate, you simply click a highlighted
word or image—known as a hypertext link—within the page displayed on your screen. This link takes
you to another page which provides you with further details on the subject. To continue, click another
link to view more information.

When you click a link, you are telling your computer to retrieve a Web page and display it on your
screen. Although the Web page is located on the Internet, the process is basically no different than
telling your computer to retrieve a file located within a certain drive and folder on your computer. Use
the Web as an easy way to find most of the information available on the Internet.

A Web page can contain text, pictures and animation you can view, and sound files you can listen to.
In some cases you can download this information to your system for later use. Hypertext links
contained on a Web page can also take you to a newsgroup, an FTP site or other places on the
Internet. Cyberjack Web switches to the appropriate Cyberjack program specified by the link. For
example, if you click a link to a Gopher site, Cyberjack Gopher starts and displays the contents of the
site.

Each page on the Web has a unique location. Like other Internet programs, specific Universal
Resource Locators (URLSs) identify every page.

A typical Web URL is shown here. Click a part of the URL to see what kind of information it supplies
about the address of the Web page.

http://www.cyberjack.com/welcome.htm

HTML Tables

Cyberjack Web supports HTML (Hypertext Markup Language) tables that are commonly used on Web
sites across the Internet. The Web page author uses tables to place text and graphics in any location
on the Web page. Without Cyberjack Web’s support for HTML tables, you would see a long column of
text and graphics when you visit a Web site with tables.

Tips
- Each Web page is a file that ends with either an .html or .htm extension.
. If you are new to Cyberjack or the Internet, connect to the Cyberjack Web page. Check this site
for updates, FAQs (Frequently Asked Questions) about Cyberjack, helpful hints and interesting places to
visit.
. To see a list of HTML tags that Cyberjack supports, see the Cyberjack 7.0 Supported HTML Tags
Web page at:
http://www.cyberjack.com/ref/htmitags.htm
The Cyberjack Web page is available at:

http://www.cyberjack.com/



What are Web search engines?

There are thousands of Web pages dealing with just about every subject imaginable. The biggest
challenge for most new users is finding information of interest.

Web search engines gather lists of the many Web sites related to the subject you select. You can
search on a specific topic within the search engine’s database, or look for Web pages by subject.

Two of the most popular Web search engines are Yahoo and Lycos. They are found at the following
URLs:

http://lwww.yahoo.com/
http://www.lycos.com/

There are many other search engines available on the Web, some of which focus on a specific topic.
For example, if you are trying to find someone’s email address, try using the Four11 search engine, at:

http://www.four11.com/

If you are looking for a subject or topic in News, you can use DejaNews, a Web search engine that
scans for keywords in individual articles. The DejaNews URL is:

http://www.dejanews.com/forms/dnquery.html

Note

- Internet addresses and the availability of search engines can change at any time. Check the
Cyberjack Web page for updates on addresses and search engines, at:

http://www.cyberjack.com/



What are secure sites?

As you surf the Web, you will see many business sites advertising items you can purchase online with
your credit card. However, many people are reluctant to provide their credit card number or other
personal information online, because Internet transmissions are not always confidential or secure.

Many business sites are now using the Secure Socket Layer (SSL) protocol to provide more secure
transmissions. Cyberjack Web uses this protocol to encrypt information that is sent to or received from
an SSL site. When you connect to a Web site that uses SSL, a padlock appears over the status bar
animated icon.

You can set up Cyberjack to display warning messages when you are connected to a nonsecure site.
For details, click here |

Note

. There is a risk that information you send over the Internet will be accessed by people other than
the intended recipient..



Cyberjack Web
To start surfing
1. On the Page menu, click New. The New Page dialog appears.
2. Type the address of the Web page. For example, to connect to the Cyberjack Web page, type ...
http://www.cyberjack.com/
... and click OK. Cyberjack Web retrieves and displays page.

3. To browse another page, click a link. Cyberjack retrieves and displays another page.

Tips

You do not have to type http:// at the beginning of the Web address in the New Page dialog.
Web pages have case-sensitive addresses.



Cyberjack Web
To save a Web page to your Guidebook

1. On the Page menu, click Save. The Save As dialog appears.

2. Inthe Save In field, click the Guidebook folder in which you want to save your new Web CyberLink.



Cyberjack Web
To return to previously viewed Web pages

- In the URL drop-down list, select the Web page you want to revisit.

[ Related Topics



Cyberjack Web
To view multiple Web sessions

Right click a hypertext link, and click Separate Connect. A new Cyberjack Web session appears, displaying
the Web page identified by the link you selected.

Note

Opening multiple sessions of any Windows program affects your system’s memory and resources. Expect
slower response times for every additional, concurrent session of Cyberjack Web you open.



Cyberjack Web
To download an embedded image
1. Right click the appropriate image.

2. On the right-click menu, click Save Image. The Save To Disk dialog appears and displays the contents of the
default download folder.

3. If required, click a different folder in the Save In drop down list and select a different folder.
4. Click Save.

O Related Topics



Cyberjack Web
To download an embedded background image
1. Right click the background of a Web page.

2. On the right-click menu, click Save Background. The Save To Disk dialog appears and displays the contents of
the default download folder.

3. Ifrequired, select a different folder in the Save In drop-down list.
4. Click Save.

O Related Topics



Cyberjack Web
To view the HTML code of a Web page

1. On the View menu, click Page Source. The Page Source window opens.

2. To close the Page Source window, click Close on the File menu.

[0 Related Topics



Cyberjack Web
To save the HTML code of a Web page

1. On the Page menu, click Save Page Source. The Save Page Source dialog appears.
2. Click Save. The HTML code is saved to the hard drive.

[0 Related Topics



Cyberjack Web
To save the HTML code of a linked Web page

1. Right click a link. Click Save Linked Page. The Save To Disk dialog appears.
2. Click Save. The HTML code is saved to the hard drive.

[0 Related Topics



Cyberjack Web

To view a Web page stored on your hard drive

1. On the Page menu, click Open Page Source. The Open Page Source dialog appears.
2. Inthe Look In field, select the HTML file name and folder to view. Click Open.

3. To display the Web page, click Open.

[0 Related Topics



Cyberjack Web

To change the Web page appearance

On the Setup menu, click Options. The Web Options dialog appears.
Click the Appearance tab.

To view graphics on a Web page, enable Display Inline Images.
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In the Item drop-down list, select any of the following:

Standard Text to change the font, size and color of standard text.
Fixed Space Text to change the font, size and color of fixed space text.
Anchor Color to change the color of the links displayed on a Web page.
Visited Anchor Color to change the color of a link you have already visited.
Active Anchor Color to change the color of a link you have selected to visit.
Background Color to select a color for the background display.

5. In the Font drop-down list, select a font for the selected text.
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6. In the Size drop-down list, select a size for the selected text.

7. In the Color drop-down list, select a color for the selected text.
Tips

O You can speed up the transfer of Web pages to your system by disabling Display Inline Images so that only
the text from the Web page is displayed.
O To return to the original appearance settings, click Reset Defaults.



Cyberjack Web
To change the default starting page

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Network tab.
3. In the Default Starting Page section, click one of the following:

O Cyberjack Home Page to set the default to the initial Cyberjack Web page.
O Last Page Visited to set the default as the last Web page you viewed.
O Blank Page to leave the Cyberjack Web window blank.

O URL to type the appropriate Web page address in the field provided. Click Current Page to insert the URL of
the current Web page you are viewing.



Cyberjack Web

To change the proxy settings

On the Setup menu, click Options. The Web Options dialog appears.
Click the Network tab.

In the HTTP Proxy section, enable Use Proxy Server.

In the Host field, type the host address.
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In the Port field, type the port address.

Notes

O Only use the HTTP proxy settings if you are connected to the Internet through a proxy server located on a
local area network (LAN). If you need more information about your network setup, contact your network administrator.
O Cyberjack Web does not support SOCKS-based firewalls.



Cyberjack Web
To change the nonsecure connection settings

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Network tab.
3. In the Security section, enable any of the following:

O Warn When Sending Nonsecure Data to display a warning dialog when you are submitting information to a
nonsecure Web site.

O Warn When Receiving Nonsecure Data to display a warning dialog when you are about to receive
information from a nonsecure Web site.

Notes

O Not all Web sites use the Secure Socket Layer (SSL) protocol to provide increased security for transferring
information. You can set up Cyberjack to warn you when you are sending or receiving data to or from a nonsecure
site.

| For more information on secure Web sites, click here
|



Cyberjack Web
To change the file transfer settings

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Transfers tab.

3. To specify a different default folder for downloading files, in the Download path field, type a new folder, or click
Browse to select a folder for downloading.

4. In the Options section, enable any of the following:

O Confirm Before Overwriting Existing Files to be prompted before overwriting a file with the same name as
the one you are trying to download.

Check for Viruses in Downloaded Programs to search for viruses in the files you download.

View Images as They Download to display image files as they are transferred to Image Manager.
Automatically Launch Downloaded Files to start the appropriate Windows program for the downloaded file.
Display Transfer History When Complete to advise you when a file transfer is complete.

Minimize Transfer Dialog to minimize the file transfer display on your screen.

Confirm File Name When Saving to be prompted to alter the name of the file you are downloading.
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Note

O Changing the entry in the Download Path field changes the default download folder for all Cyberjack
programs. To view the contents of the default download folder, click Open Download Folder on the Tools menu.



Cyberjack Web
To change the notification settings

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Notification tab.

3. In the When Transfer Complete section, enable any of the following:

O Flash Icon to have the Cyberjack Web icon flash on the Windows Taskbar (if Cyberjack Web is minimized) to
indicate a completed file transfer.
O Restore Minimized Application to restore Cyberjack Web to your screen when a file transfer is complete.
O Play Sound to play a Windows system sound to notify you that a file transfer is complete.
4. In the Group Transfers section, click one of the following:
O Notify After Each Transfer to advise you when each individual file in a group transfer is complete.
O Notify When all Transfers are Complete to advise you when all the files you selected are downloaded to your

system.



Cyberjack Web
To change the cache settings

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Caching tab.

In the Caching section, click one of the following:

None to save no information from previously viewed Web pages to the cache.

Text to save only the textual information from previously viewed Web pages to the cache.

Text and Images to save all information from previously viewed Web pages to the cache.
4. In the Clearing section, click one of the following:
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O Never to prevent the cache from ever being cleared.
O After to set the number of days information should be kept in the cache. The default is 31 days.
O After Every Session to clear cache contents at the close of every Cyberjack Web session.

5. In the Verify Documents section, click one of the following:

O Once per Session to verify if any changes have taken place in the contents of a Web page once during a
Web session.

O Always to continually verify for changes on a Web page during a Web session.

O Never to not verify any changes made to a Web page during a Web session.

Note

O Cyberjack Web uses a cache on your hard drive to store previously viewed Web pages. A cache is a
temporary memory store that saves recently accessed data for faster retrieval.



Cyberjack Web
To specify an application to run a certain file type

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Types tab.
3. Click New. The Create New Mapping dialog appears.
4. In the Map Details section, add the following information:
O In the Type field, type the name of the file type to associate.
O In the MIME Types field, type a description of the Mime type for the file type to associate.
O In the Extensions field, type the file name extension of the file type you are adding.
5. In the Application section, do the following:
O Enable Launch Automatically so Cyberjack Web starts the associated program for the file type once it is
successfully downloaded.
O In the Launch field, type the path and name of the program to run the associated file type specified in the
Map Details section. If you are unsure of the exact path and file name, click Browse.
Notes
O Before changing these settings, make sure you know the Multimedia Internet Mail Extension (MIME) and file
name extension for the associated file type.
O The Use Inline Viewer option is only available for file types supported within Cyberjack.

[ Related Topics



Cyberjack Web
To edit an application for a certain file type

On the Setup menu, click Options. The Web Options dialog appears.
Click the Types tab.

Select the program to edit, and click Modify.
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In the Map details section, change any of the following:

In the Type field, enter the name of the program.

In the MIME Types field, enter a description of the MIME type for the program.

In the Extensions field, add the file name extension or extensions for the program you are adding.
5. Disable Use Inline Viewer. The Application section becomes active.
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6. In the Application section, add the following information:

O Enable Launch Automatically so Cyberjack Web starts the associated program for the file type as soon as it
is downloaded.
= In the Launch field, type the path and name of the program to run the associated file type specified in the

Map details section. If you are unsure of the exact path and name of the file, click Browse.

[0 Related Topics



Cyberjack Web

To remove an application for a certain file type

1. On the Setup menu, click Options. The Web Options dialog appears.
2. Click the Types tab.

3. Select the program to remove, and click Delete.

[0 Related Topics



Viewing Hypertext Markup Language source files

You can use Hypertext Markup Language (HTML) to create your own Web pages. With Cyberjack
Web, you can examine the HTML code used in other Web pages, save the code to your hard drive, or
preview the HTML code in Cyberjack Web.

The contents of many Web pages are copyrighted. Consult with the author of a Web page before using
the code to help you construct your own page.

For a list of the HTML tags supported by Cyberjack Web, see the Cyberjack Web page, at:

http://www.cyberjack.com/

O Related Topics







The protocol for moving hypertext files across the Internet. Requires an HTTP client program on one end, and an
HTTP server program on the other end. HTTP is the protocol used by the World Wide Web (WWW).



The main communications protocol in the Internet suite of protocols that provides reliable, connection-oriented, full
duplex streams and uses IP for delivery.



Action messages are brief descriptions of what you want the other users to picture you doing. For example, if
another user says something funny, you might post the action message “Raven giggles”. Action message are
automatically preceded by your nickname, so write your action in the third person. For example:

*Raven waves hello to everyone



Private action messages are sent only to the specified user, preceded by your nickname. For example:
*> Raven winks at you secretly ...

Your nickname does not appear in the Action field, but it will be the first word of your action message.



Points to a specific Web site.



A file that contains characters other than the standard ASClicharacters. Binary files cannot be read like text files;
they are usually executable programs or compressed files.



An abbreviation for American Standard Code for Information Interchange. This standard code consists of 7 data
bits (or binary values) per character. Letters, numbers, and special characters (for example, $,y,#, %) are

represented by different ASCII codes. The ASCII character set represents 96 printable characters and 32 non-
printable control characters.



A Cyberjack bookmark object that as acts a direct shortcut to an Internet site. You can create CyberLinks to your
favorite sites, and send them to other users through email. Also, any URL you can takes you to another site when
you double click it is also a CyberLink.



Hypertext Markup file. This file type can be read directly by Cyberjack Web.



A pointer to remote sources on the Internet.



Control the way you search by selecting Exact, Case Sensitive, Case Insensitive or Regular Expression.



When lurking, you are watching the chat to learn more information about the terms and expressions used in the
chat.









Enables you to change the name given to the file when saving encoded binary attachments to disk. The default name is usually
specified in the attachment, but may sometimes be based on the subject of the message.



Enables you to reorder messages when attempting to save an encoded binary attachment that has been split across multiple
messages. |t sometimes happens that the separate parts of the attachment appear in the wrong order, and it is necessary for you to
reorder them to get the attachment to decode correctly.



Your user name or identifier for this service.
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User authorization password. Any characters you type are hidden by a



Click to not save anything to the cache.



Click to save text only to cache for quick retrieval.



Click to save everything to cache for quick retrieval.



Click to never clear the cache. Oldest item in cache is lost when it runs out of space.



Click to clear cache contents after specified period.



Click to clear cache contents after specified period.



Click to clear cache every time you start Cyberjack Web.



Clears contents of the cache.



Specify size of the cache as a percentage of free hard-drive space.



Click to have Cyberjack Web automatically connect to the Cyberjack Web page.



Click to have Cyberjack Web automatically connect to the last Web page you visited.



Click to not have Cyberjack Web automatically connect to a Web site.



Click to have Cyberjack Web start at the specific Web page.



Type the URL of the Web page you want Cyberjack Web to automatically connect to. Click "Current Page" to default to the Web
page you are connected to.



Type the URL of the Web page you want Cyberjack Web to automatically connect to. Click "Current Page" to default to the Web
page you are connected to.



Enable to use Cyberjack Web through a Proxy server.



Type the IP and Port settings for the Proxy server. If you are unsure of the proper settings, contact your System Administrator.



Type the IP and Port settings for the Proxy server. If you are unsure of the proper settings, contact your System Administrator.



The Universal Resource Locator of the Web page.



The MIME type of the Web page.



The title of the Web page.



Plain text. #1



Alink that leads to another Web page. #2



Fixed space text. #3



Alink to a Web page already visited. #4



Alink to the active Web page. #5



List of all currently associated programs.



Click to add a new program association.



Click to edit the program association.



Click to delete the program association.



The name used to describe this association.



The program to run when a downloaded file’s extension matches this association.



Click to select a new application to run for the associated file.



Downloaded files matching this MIME type launch the associated application.



Downloaded files matching this MIME type launch the associated application. Separate multiple file extensions with a comma (,).



Enable this function to display supported file type in Cyberjack Web.



Enable to automatically activate an external program when a downloaded file matches the association.



The security method in effect for the current page. #9



Enable to display in-line images.



Click to start the Web wizard to guide you through the process of accessing a Web page.



Type the URL of a new Web page. For example: “www.cyberjack.com”.



Enable to be warned when you are sending data over an insecure connection.



Enable to be warned when you are receiving data over an insecure connection.



The time date and time the current Web page was last modified.



The Web page in the cache is checked against that at the original Web site to ensure that it is the most up-to-date version once per
session.



The Web page in the cache is checked against that at the original Web site to ensure that it is the most up-to-date version whenever
it is retrieved.



The Web page in the cache is never checked against that at the original Web site.






Your password for the Guidebook.



Your password for the Guidebook.



Lists the folders and files in the selected location.



Lists the folders and files in the selected location.



Type the name of the file.



Type the name of the file.



Selects the type of file to save.



Selects the type of file to save.



Opens the file with the name, file type, and location you specified.



Saves the file with the name, file type, and location you specified.






Select the item to change its appearance.



Select a new size for the selected text item.



Select a new color for the selected text item.



Select a new font for the selected text item.



Returns the color, font and size of all items to their default settings.









The status of Cyberjack Ping’s search for the specified Internet address.



The result of Cyberjack Ping’s last data packet sent to the specified Internet address.



The average response time, in milliseconds, of a returned Cyberjack Ping data packet.



Click to have Cyberjack Ping send data packets to the specified site.



Type the site for Cyberjack Ping to diagnose.






Enable any item in this list to display the selected toolbar. You can edit or delete any selected toolbar.



Click to edit the currently selected toolbar.



Click to create a new toolbar.



Click to delete the currently selected toolbar.



Enable to display buttons in color.



Enable to display Tooltips when the mouse cursor is placed over a button.



Enable to display large buttons.



Enable to display Delrina WinFax style buttons.



Enable to display Delrina WinFax style captions for buttons.



Add or remove buttons from the selected toolbar. Click the name of the toolbar to change its name.



Type a new name for the toolbar.



Use these buttons to make up your toolbar. You can drag them up to the toolbar, or click the Add button.



Adds the button highlighted in the available field to the toolbar above.



Removes the button highlighted in the above toolbar.



Resets the toolbar to its original(default) settings.



Lists the menu options that can be assigned to the buttons.



Specifies the caption that is to be displayed when Delrina Classic button style is chosen with captions.



Specifies the tooltip that is to be displayed for the button.



Specifies the help text that is to be displayed for the button.



Save the changes to the toolbar and continue.



Throw away changes to this toolbar.



Type the path and name of the folder to receive all downloaded files.



Enable to confirm overwriting existing files.



Enable to view partial images as they are downloading.



Enable to open files when they are downloaded.



Enable to show the Transfer Summary window when files are downloaded. Use this window to open or delete files.



Enable to minimize the transfer dialog. The minimized dialog appears at the bottom of the screen.



Enable to change the default name of files before downloading them.



Enable to flash the icon of a minimized Cyberjack program on the Windows Task Bar when files are downloaded.



Enable to maximize a minimized Cyberjack program when files are downloaded.



Enable to play a Windows system sound when files are downloaded.



Enable to notify you when each file transfer in a group transfer is complete.



Enable to notify you when a group transfer is complete.



Enable to set up the type of notification you want when files are downloaded.



Specify how you want to be notified after group transfers.



Browses for the folder to receive all downloaded files.



Specify the options for file transfers.



Enable to check for viruses in the downloaded files.



Connects to a new Web page.



Opens Web page CyberLink.



Closes Web page.



Saves Web page to Guidebook.



Saves Web page to Guidebook with new name.



Loads Web page HTML code from disk.



Saves Web page HTML code.



Displays Web page properties.



Changes printing options.



Prints Web page.



Email Web page CyberLink.



Closes the program.



Cuts selected text to Clipboard.



Copies selected text to Clipboard.



Inserts Clipboard contents.



Selects all text.



Finds specified text.



Repeats last find.



Toggles Toolbars.



Toggles Status Bar.



Views HTML code of Web page.



Go to previous Web page.



Go to next Web page.



Reloads Web page.



Diagnoses an Internet connection.



Displays contents of Download folder.



Changes Cyberjack Web options.



Upgrades Cyberjack.



Displays index of Web Help topics.



Displays index of Cyberjack Help topics.



Toggles the Cyberjack Web wizard.



Toggles Tip of the Day.



Displays program information, version number and copyright.



Stops data transfer.



Click the What's This button, and then click a menu command or screen component to receive context sensitive help.






Lists the available folders and files.



Lists the folders and files in the selected location.



Type the name of the file.



Selects the type of file to save.



Closes this dialog box without saving any changes you have made.



Saves the file with the name, file type and location you specified.






